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About CASA

The Centre for Advanced Spatial Analysis (CASA) is 
an initiative within University College London (UCL) 
to develop emerging computer technologies in several 
disciplines which deal with geography, space, location, 
and the built environment. It is affiliated with the Bartlett 
School of Architecture and Planning, and it provides a 
forum for interdisciplinary research focused on cities and 
their environments. 

About UCL

University College London is one of the constituent 
colleges which make up the University of London. Founded 
in 1826 by the philosopher Jeremy Bentham, it is one 
the world’s top universities in terms of the impact of its 
research and teaching.

About NCeSS and ESRC

The National Centre for e-Social Science (NCeSS) is funded 
by the Economic and Social Research Council (ESRC) to 
investigate how innovative and powerful computer-based 
infrastructure and tools developed over the past five 
years under the UK e-Science programme can benefit the 
social science research community. This infrastructure 
is commonly known as the ‘Grid’. CASA is funded as a 
node within NCeSS and the technologies presented in this 
booklet represent one of the research foci of the Centre.
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The world of geographic analysis and visualisation has changed.  New 
task specific software packages and services have emerged that have 
fundamentally changed the way we share, communicate and distribute 
information.  These changes have steadily emerged since the mid 1990’s 
and it is now quite clear that the connectivity produced through the 
internet lets us interact across time and space in ways that our ancestors 
could only dream about.

This booklet is testament to such change.  It has been produced through 
a Web 2.0 typical self-publishing service such as ‘Blurb’ that breaks the 
traditional publishing model allowing rapid print on demand documents to be 
produced.  The booklet is aimed as the start of a ‘recipe’ book for Geographic 
Virtual Urban Environments (GeoVUE) which we will update frequently 
through both Blurb and other rapid printing methods.

Much of the work reproduced here is based on applications at the Centre 
for Advanced Spatial Analysis (CASA) at University College London and 
particularly its GeoVUE project.  GeoVUE is one of seven nodes in the National 
Centre for e-Social Science (NCeSS) whose mission it is to develop grid and 
web-based technologies for the social sciences.  Our project at CASA is to 
develop new applications of GIS and related technologies which are focused 
on 2D and 3D mapping and CAD.  The express aim is to develop new kinds of 
virtual urban environments (VUEs) through which users can participate in 
furthering their understanding of cities as well as engaging in other forms of 
participation.

The mapping hacks and techniques that we have developed enable users to 
take any data in an appropriate mapping file and convert this to a form where 
it can be immediately visualised in a web page, in the spirit of Web 2.0.  The 
key to all this is location, geography.  We argue here that location and space 
now represents a third force in information technology besides computers 
and communications.  Tagging not only the type of information but where 
such information is produced, who uses it and at what time, is fast becoming 
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the killer application that roots 
information about interactivity 
generated across the web to 
systems that users can easily 
access and use in their own 
communication with others.  

Already much is being 
accomplished and mapping 
systems such as Google Maps 
are simply in the vanguard 
of a whole series of software 
systems and virtual worlds that 
promise to bring geo-location to 
the fore.  This is at the heart of 
this booklet.  The re-emergence 
of the importance of geography 
in the Web 2.0 world is becoming 
known as ‘Neogeography’.  This 
is a geography for the everyday 
person using Web 2.0 techniques 
to create and overlay their 
own locational and related 
information on and into systems 
that mirror the real world.  The 
term derives from Eisnor (2006), 
one of the founders of www.
platial.com, where she defines 
Neogeography as: “…a diverse set 
of practices that operate outside, 
or alongside, or in the manner 
of, the practices of professional 
geographers”.  

Rather than making claims 
about scientific standards, 
methodologies of Neogeography 
tend towards the intuitive, 
expressive, personal, absurd 
and/or artistic, but may be 
idiosyncratic applications of ‘real’ 
geographic techniques.   Turner 
(2006) expands the definition 
considerably in his pamphlet on 
the various techniques which 
non-professional users now have 
at their disposal.  He says: “…a 
Neogeographer uses a mapping 
API like Google Maps, talks about 
GPX versus KML and geotags 
his photos to make a map of his 
summer vacation”.  

Essentially, Neogeography is 
about people using their own 
maps, on their own terms 
and combining elements of 
an existing toolset.  As part 
of GeoVUE we have built and 
distributed our own ‘toolset’ for 
geographic visualisation.

Welcome to a new world of 
rich geographic information 
available anywhere, anyplace, 
anytime.
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The city has become the focal 
point of visualisation in the last 
18 months, mainly due to the rise 
of the Digital Earth, advances in 
computer graphics cards and the 
launch of free place-based and 
3D modeling software.  It is also 
down to location and the density 
of population.  As the majority of 
users of web-based geographic 
information and visualisation 
systems currently live in cities  
or a least urban areas, it is not 
surprising that the city is one of 
the key metaphors of Web 2.0.  

The ways locational information 
can be added to these 
applications where a website or 
application combines content 
from more that one source into 
an integrated experience, is 
known collectively as a ‘mashup’.  
In many ways, Neogeography 
and mashups go hand in hand.  
Our 3D Virtual London model 
is a mashup as such, a mix of 
information and data from 
many sources, changing and 
morphing according to the 
viewing platform and end user’s 
requirements.  The primary aim 
of our model has been to inform 

the public and professionals 
alike about the future of the city.  

One of the prospects of Web 2.0 
for virtual cities is that as these 
cities develop over time, new 
software, new data sources and 
new ways of digital building 
will become available.  The 
fluidity that Web 2.0 enables 
with its focus on individualized 
updating of information in the 
location sense, augurs well for 
highly responsive and timely 
interventions in real cities.  
Indeed it is the fluidity of the city 
that is key to Neogeography as a 
whole.

Without question, the most 
important innovation in the 
development of the digital 
city, Neogeography, and the 
mashups that accompany it, 
is the concept of the Digital 
Earth.  Google Earth and to an 
increasing extent Microsoft’s 
Virtual Earth and NASA’s World 
Wind have produced 3D cities at 
a speed and resolution that was 
unimaginable only a few years 
ago.  



9

Visualising the City

Digital Geography: Geographic Visualisation for Urban Environments Chapter One

These cities act as layers for 
information, a rich canvas onto 
and into which information 
can be inserted and extracted 
at will over the network.  In 
essence they act as ‘space inside 
the machine’, a space that 
can be iconic, photorealistic 
or multifaceted depending 
on a user’s preference.  It is 
into this space that spatial 
analysis, digital geography and 
geographic information systems 
(GIS) operate as software for 
analysing space.  

It is in these virtual and network 
spaces that people are building, 
creating and indeed occupying 
digital cities.  

We will explore the concept of 
the Digital Earth and virtual 
environments such as Second 
Life later, but for now it is worth 
looking at the graphic ‘Where 
will the people go?’ adapted from 
the garden city movement, an 
approach to urban planning that 
was presented in 1898 by Sir 
Ebenezer Howard.  

The three magnets pull people 
between the Town and the 
Country.  In today’s Web 2.0 
world we have digital cities 
which are becoming increasingly 
populated and perhaps it is time 
for a new magnet - that of the 
Virtual Town-Country?

Indeed Hillier (1996) actually 
defines ‘space as the machine’.  
In a Web 2.0 world of increasing 
software and infinite capacity for 
information, we can import the 
city into the machine, digitally, 
in a recursive fashion whereby 
the machine actually becomes 
the ‘space’.

Ebenezer Howard’s Three Magnets
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In terms of pure visualisation, 
the production of photorealistic 
models of the built environment 
is key to the creation of visual 
space.  Yet it is a time consuming, 
manual process and one that up 
until recently was in the domain 
of professional photogrammetry.  

The standard approach to 
producing a photogrammetric 
reconstruction of the city 

has been through the use of 
calibrated images and matching 
control points.  

The image illustrates the 
development of one of the key 
buildings along the north bank 
of the River Thames which is 
modelled using a combination 
of oblique photography from 
helicopter capture and ground 
based imagery.  

The model took approximately 
two days to produce.   

In today’s Google-led world 
which is based on releasing free 
software with high levels of 
functionality combined with low 
levels of required expertise, it 
is now possible to considerably 
reduce the time taken to produce 
such models.  Google SketchUp 
is a unique program that is 
available in both professional and 
freeware versions.

The differences between the 
free and professional versions 
are negligible and are only 
significant in terms of importing 
and exporting data.  

This now means that the public-
at-large are able to photo model 
through SketchUp and produce 
their own sections of the city - 
aka Web 2.0.   Google SketchUp is 
linked directly with Google Earth 
which we examine further a little 
later, and it is linked to this for a 
good reason – so that users can 
develop free content.   

Modelling using 
oblique and ground 
based photography
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Rapid Streetscape 
modelling in Google 
SketchUp

Creating a Digital 
City, one that reflects the actual 
built form, is a huge task and 
therefore time consuming.

So far, the only groups that 
have been able to get close to 
representing the city visually are 
Games companies such as Sony 
and more recently Microsoft.

The results of 
such developments are 

impressive but the costs 
are typically in the order of  

millions of dollars to produce, 
while the models are also only of 
use for gaming.  

They cannot be easily ported 
into contexts either where 
geographical analysis is 
required or where the public at 
large can interact with them,  

largely due to 
the nature of their 

construction.  Therefore 
to reduce cost, Google have 
released their SketchUp 
software so the users-at-large 
can produce the city themselves, 
block by block, building by 
building.  

Of note is the latest version of 
SketchUp which, at the time 
of writing, allows users to 
import and calibrate their own 
photography, directly modelling 
over the imagery.  
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University College 
London Quad 
modelled in 
Sketchup

Although not as accurate as 
traditional photogrammetry, 
it does allow rapid modelling 
and the widespread adoption of 
photorealistic content.

The image illustrates output 
using the ‘Camera Match’ 
component in SketchUp.  Camera 
Match allows models to be 
rapidly created using standard 
images from a digital camera or 
camera phone.  It is easy to use 
and opens up the possibility for 
the rapid capture of anything 
from individual buildings to 
entire streetscapes.   

We will look closer at SketchUp 
and more particularly the 3D 
Warehouse and its impact on the 
Digital Earth later…
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New companies offering city 
based visualisations are 
emerging at an ever increasing 
rate.  One company is www.
edushi.com who have produced 
some of the best 2.5D city maps 
we have seen to date.  Of note 
is Edushi’s (short for e-City in 
Chinese) concentration on ‘sim-
city’ style graphics and despite 
the models being produced 
in a 3D modeling package, 

their distribution, as 2.5D 
perspective viewpoint graphics, 
is convincing.

The interface to Edushi is  
similar to Google Maps with 
the ability to search for local 
restaurants and businesses 
according to location.  
Placemarks are loaded 
accordingly over the map 
creating the opportunity to 

overlay data exported from a 
similar viewpoint.  

There are currently over 250 
maps in the Edushi collection 
with a series of western cities 
promised in the next year.   For 
simple access to information and 
a sense of location and place, it is 
sometimes difficult to beat this 
perspective viewpoint.  

Shanghai in www.edushi.com
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Real-time visualisation of 
cities or any large geographic/

architectural scene is computer 
intensive and thus dedicated 

software is often required.

Game engines are generally 
overlooked in terms of 

visualisation yet they are 
without question the most 

powerful and cheapest way to 
visualise entire cityscapes. 

The majority of new games come 
with a ‘sandbox’ mode that allow 

the user to essentially strip out 
the game and import one’s own 
models – this gives a longer life 

to the game as users create and 
share their own content.

Our examples pictured here are 
running in the Crysis Sandbox 

(top image), produced by Electronic 
Arts, and Oblivion (bottom image) 

from Bethesda.
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Visualising the city is often 
linked to real world cities as in 
all our examples explored so far.  
However to explore geography 
and architecture, it is sometimes 
beneficial to use ‘fantasy cities’ or 
‘fantasy architecture’ as a base 
for exploration and learning.

Fantasy cities get around any 
issues of data copyright and 
can open up exploration of 
issues relating to space, place, 
architecture and planning to 
a wide audience.  We organised 
an outreach activity with Noel 
Jenkins, a geography teacher 
from Court Fields Community 
School in Dorset to explore how 
his class of 11 year olds would 
design a future skyline.  

Here are some examples of what 
the children produced...

Fantasy Architecture in 
3D Studio Max
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Noel’s class of 11 year olds had been learning about Urban Land Use and 
Digital Geography, a subject that is perfect for fantasy architecture.  
The pupils sent in drawings of their chosen building and the best 
submissions were rendered in 3D for visualisation in both 
Studio Max and Google Earth.

At the end of the project a prize was 
awarded, in the form of a 
gift voucher, and the 
pupils made a short 
movie of their 
experiences.
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Panoramic images have not 
been brought about by the rise 
of the digital age; indeed they 
have been in existence since the 
1840’s with the introduction of 
the first dedicated panoramic 
cameras.  However, it was not 
until 1994 with the introduction 
of a subset of Apple’s QuickTime, 
known as QuickTime Virtual 
Reality that panoramic 
production, based on the 
stitching together in sequence of 
a number of photographs, became 
available for the first time.

Capturing panoramas used to be 
a fine art of manipulating each 
image.  Blending layers in Adobe 

Photoshop took time and the results were notoriously poor.  Our first digital 
panoramas were captured using a Casio digital camera running at 640x480 
resolution and a battery life that resulted in a single capture between 
charges.  

Thankfully things have changed.  Consumer level digital cameras are now 
approaching the 10+ megapixel range and stitching software has become so 
advanced that panoramas can be captured using a standard mobile phone, 
such as the Nokia N95.

In fact the Nokia N95 with its built in GPS, 5 megapixel camera and Wifi has 
become the current ultimate Neogeography device.
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Creating Panoramas with a Camera Phone
Software: www.cs.ubc.ca/~mbrown/autostitch/autostitch.html

Taking panoramas used to be an 
art form that took considerable 
knowledge, a lot of heavy 
hardware and the semi-manual 
placement of control points in 
complicated software. 

Things have changed and in our 
first tutorial on panoramas we 
show how it is possible to create a 
high resolution panorama using  
a simple camera phone and freely 
available software.  This allows 
one to capture a scene at anytime 
creating spontaneous panoramas 
which, as we will see later, can 
then be embedded into either 
Google Maps or Google Earth.

We have used the Nokia N95 for 
our first example as it features 
a 5 megapixel camera, although 
the general rule is the higher 
the resolution the better.  Taking 
note of the techniques, any 
camera phone or indeed standard 
digital camera can be used to 
create a panorama.

You will need:

1 x Mobile Phone •	
(we used the  
Nokia N95) 

1 x Copy of •	
AutoStitch

Time Required:  
15 to 30 minutes
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Taking the Photographs

1)	 Set up your camera phone 		
to capture images at the 
highest resolution, in our case 
5 megapixels.

2)	 If possible choose a mode in 
which to photograph; in our 
case we used ‘Landscape’ 
as this ensures a constant 
focus throughout the capture 
process.

3)	Stand in your location with 
the camera roughly at arms 
length and take your first 
image.

4)	 The secret to a good panorama 
is trying to firstly make sure 
the nodal point (lens) is kept 
central for each of the images 
and secondly that there is a 
20% overlap with each shot. 
As such the aim is to make the 
camera the point of rotation 
and move around taking your 
second image so it overlaps 
the first one - as our first four 
images on the previous page 
illustrate.

5)	Carry on working your way 
around the scene until you are 

back where you started.  You 
should take approximately 14 
images for a complete circle.

6)	To increase the field of view 
of your panorama - i.e.  to 
include more of the ground 
or the sky - simply tilt your 
phone upwards or downloads 
accordingly and go around 
again. 

That’s it.  The image 
capturing process should take 
approximately 5 minutes.

Completed Panorama
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Stitching the Images

We have used the freely available ‘AutoStitch’ software to merge the images 
into a panorama, although other stitching software is available, notably 
PTGui which we will be looking into in the next tutorial.  PTGui provides a 
better blend of colours, but AutoStitch is free, quick and simple.

1)	 Download AutoStitch and 
install it on your machine.

2) 	Run AutoStitch and choose 
File > Open - then select all of 
your images.  This will run a 
quick low resolution test stitch 
to ensure the images align.  
Once you are happy that the 
panorama has worked, go 
to Edit > Options and set the 
scale to 100%.  Reopen your 
images and sit back and wait. 
A typical stitch will take 
approximately an hour on a 
recent specification computer.

You should now have a completed 
panorama taken using your N95 
- our scene resulted in a 40Mb 
JPEG at 18100 x 3766 pixels.

Once captured, your panorama can be used in numerous ways from uploading 
to Flickr to embedding in Google Maps, viewed in full resolution using our 
Image Cutter software or placed inside of Google Earth.   
More on this a little later.

AutoStitch



Capturing the City

To take panoramas a step 
further, you need a tripod and 
a professional camera rig.  We 
use a Nikon D80 camera with a 
10.5mm fisheye lens for our 100+ 
panoramas which are online at 
www.digitalurban. 
blogspot.com.
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With such a set up, a complete 
180 x 360 degree panorama 
can be captured in just 9 
images. This makes it easier to 
blend out moving objects while 

maintaining high resolution for 
print or visualisation in systems 
such as Second Life or Google 
Earth.  Panoramas are one of the 
most versatile but rapid ways 

to geographically capture the 
city.  In some ways they present 
a better representation of space 
than any three dimensional 
model as they capture a  
complete moment in time.

Millennium Park, Chicago
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Just as in the real world, 
panoramas can also be created in 
any virtual world or game such 
as Second Life, Oblivion or Half 
Life to name but three.

All that is required is the ability 
to grab screen shots from the 
player’s point of view and to 
rotate around the all important 
nodal point.

Most games and Digital Earth 
systems have such a ‘viewpoint’ 
option, often known as ‘first 
person’, or ‘mouse’ mode.

Capturing such images allows the 
creation of a unique point of view. 
This, combined with Microsoft’s 
roll out of photorealistic cities in 
their Virtual Earth, allows for 
the creation of stunning high 
resolution images in just a few 
simple steps. 

Over the next couple of pages 
we provide examples and detail 
about how to easily create such 
images.

New York Panorama captured  
from Microsoft’s Virtual Earth
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New York
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Creating Panoramas from Microsoft’s Virtual Earth

Step 1:

Load Virtual Earth by going 
to www.maps.live.com 
and selecting 3D - type in 
your desired location and fly 
approximately 100 metres above 
the ground.  For our example, 
we choose New York due to the 
inclusion of 3D buildings.

Step 2:

Place Virtual Earth into ‘First 
Person’ mode - Press the CTRL+Q 
keys on your keyboard.  Moving 
the mouse will now allow you 
to rotate around a single point. 
Scroll the mouse wheel forward 
to decrease your altitude, and 
scroll the mouse wheel backward 
to increase your altitude.

Step 3:

Grab screen shots of the view to 
ensure you have full coverage of 
the area.  We used FRAPS (www.
fraps.com) to grab the screen 
images but any method of screen 
capture will work.

You will need:

1 x Virtual Earth•	
1 x Screen capture 	•	
	 program
1 x Image Stitcher •	

Time required:  
30 minutes to one hour
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Depending on your screen’s 
aspect ratio, it will take between 
24 and 36 images.  Each image 
should allow 25% overlap to the 
previous capture.  On a Dell 21 
inch monitor at 1680 x 1050 
pixels, a complete panorama 
requires two rows of 12 images 
and a single final image looking 
down to complete the coverage.

Step 4:

The images can be stitched in any 
stitching software.  Our tutorial 
uses PTGui which is available 
as a 30 day trial download from 
www.ptgui.com.

Open PTGui.  Click ‘Select Source 
Images’, navigate to where you 
saved your screengrabs and 
select them all.

Step 5:

Once the images are loaded, 
a Camera Lens Dialogue will 
appear.  Simply click ‘Cancel’ and 
your images will now be loaded 
ready to stitch.

Step 6:

Click ‘Align Images’.  PTGui 
will now analyse each image 
and automatically extract 

overlapping points, creating your 
final panorama. 

Once stitched simply click ‘Create 
Panorama’ and save.

The first thing you notice is 
the lack of clouds.  Microsoft’s 
Virtual Earth does not include 
any weather effect.  The sky is 
simply an even coloured blue.

As such it allows a false sky to be 
simply pasted and blended in.

A complete 360 degree panorama  
of New York City



San Francisco Digital ‘Planet’
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Creating a Photographic ‘Planet’

You will need:

1 x Panorama •	

1 x Photoshop, •	
Paintshop Pro or 
Similar

Time required:  
5 minutes

The ‘round’ image on the previous page is known as a ‘planet’.  Take a look on 
Flickr and you will find whole ‘pools’ dedicated to panoramas that have been 
transformed with this projection. 

They are easy to make.  Once 
you have done the hard part and 
created your panorama, it is only 
a few simple steps to creating 
images that really stand out.

Subjects that are suitable for 
making planets are photographs 
that have a clear sky and ground 
area as these are the parts of the 
image that are most noticeable.

As such they are perfect for use 
on urban panoramas as they 
provide a unique way of viewing 
the urban architecture.



Step 1

Open the original panorama in 
Photoshop or similar.

Step 2

The images need to be square, so resize accordingly. 
Ours is 3000 x 3000 pixels.

Step 3

Chose Filter > Distort > Polar Coordinates.  Select 
‘Rectangular to Polar’ and you’re done. 
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If you would like to create more 
advanced planet type images, 
it is well worth downloading 
a Photoshop plugin known as 
‘Flexify’.

Flexify provides a 30 day free 
trial of its plugin allowing any 
number of projections and views 
to be created from panoramas.

www.flamingpear.com/ 
flexify.html

The  Navy Pier 
in Chicago

Main Street Chicago
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Panoramas are unique starting 
points into visualising space 
and as we will see in the coming 
pages, they can be visualised 
directly online, embedded into 
Google Earth and used to create 
‘step inside’ urban spheres in 
Second Life.

With the addition of high 
dynamic range techniques of 
capture, they provide a source 
of dynamic lighting for 3D city 
models.  Any scene can now be 
captured and mapped with a 
simple mobile phone or standard 
digital camera.

High Dynamic  
Range Panorama
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Google Maps has changed 
everything in the online 
geographic world.  Where once 
data was restricted to slow and 
cumbersome servers from the 
large GIS software companies, 
Google came along and made it 
easy.  They provided a base layer 
on which to overlay information 
whereby users can pan (by 
dragging the mouse) and zoom 
(by using the mouse wheel) 
onto mapping information from 
almost anywhere in the world. 

In short, Google has made 
mapping easy, opening up 
geographic information to 
the masses and leading the 
way to Neogeography, Crowd 
Sourcing, Volunteered Geographic Information 
and Collective Intelligence.  Google Maps was 
first announced on the Google Blog on February 
8th, 2005 with the main service launching as a beta on 
October 6th of the same year. 

In little under three years, mapping is now a central part of 
the internet experience and indeed geography is important 
again.  With this rise in mapping has come a demand for data, 
issues of copyright, questions over accuracy, but above all there has been an 
explosion in the amount of geographic information available.  The coming pages 

Street and Aerial View of the 
Barbican via Google Maps
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provide a walk through of some 
of our software launched under 
GeoVUE, and we introduce 
MapTube  ‘A Place to Put Maps’ 
which is our own Web 2.0 
application.

To aid social scientists who have 
map and other picture data but 
are not interested in acquiring 
the detailed and often arcane 
skills for manipulating such 
data within a proprietary GIS, 
we have developed as part of 
GeoVUE software to take in 
such data and display it directly 
within a Google Map.

In short, our software GMap 
Creator enables a user to take 
a map which consists of vector 
data describing the physical 
configuration of objects and 
features that make up the 
map together with attributes 
that relate to these geometric 
features, and then to generate 
a layer that can be displayed/
overlaid in a Google Map.

London Data with Google 
Maps as a Background



Creating a Google Map Overlay using GMap Creator
Software:  www.casa.ucl.ac.uk/software/googlemapcreator.asp
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Google Map Creator has been created to publish .shp files in a simple ‘point 
and click’ manner.  The .shp or Shapefile is a popular geospatial vector data 
format for geographic information systems software. 

The format is developed and regulated by ESRI as a (mostly) open spec-
ification for data interoperability amongst ESRI and other software products. 
As such, the majority of geographic data can be converted to .shp files.

You will need:

1 x GMap Creator•	
1 x Shape File•	
1 x Webspace•	

Time required:  
5 to 10 minutes

A search of the web for ‘free .shp’ files will 
produce numerous examples of data sets 
that can be shared online.  We also provide 
a free example to download and use on our 
website from the URL above.

Although the main use of Google Map 
Creator will be by data providers and local 
councils, all the visualisations produced 
can be shared and ‘mashed’ using MapTube 
which we explore later.



Step 1
Launching and Loading Google Map Creator

Download the software from our website and unzip into a folder.  Note the 
software requires Java to be installed on your system which, if required, can 
be downloaded from www.java.com.

To start Google Map Creator double click on ‘gmapcreator1.1.jar’ which can 
be found in your install folder.  Or, if you are a Windows user you can simply 
select the software from your Start > Programs option.
 
Once the software is running, Select File > Open File and choose the .shp file 
you wish to display in Google Maps.   For our example we are using a world 
map ranking by Gross Domestic Product (GDP) by country.

Once loaded, the Shapefile will be automatically re-projected into Mercator, 
which is the projection format used by Google Maps.  All that we need to do 
now is to set the colours and save into a web directory.

Step 2
Setting the Colours

The map will load in a single 
colour surrounded by a pinky/
purple background.  The 
background is simply to indicate 
where there is no data, it will not 
be visible in the final output.

You can choose to display any 
attribute that is attached to the 
data, according to your .shp file.

Select your required data from 
the drop down - in our case 
‘Rank’

To set the colours, select the  
‘Cols’ button and this will bring 
up a dialogue box where the 
colour scale, according to your 
output range, can be chosen.

Google Map Creator
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For our scale of ranked GDP, we 
have selected 6 categories and 
selected colours accordingly. 
This should only take a couple 
of minutes.  Once you are done, 
click ‘Apply’ and the map will be 
coloured in relation to your scale.

With a coloured map you are now 
ready to set the level of zoom 
and select the area of the map 
to create.  Most of the time you 
will want to publish your entire 
map, but if you would like to only 
export certain areas, you can use 
the + and - buttons to zoom in. 

The area of the map you see in 
the window is what will finally 
get published.

On the right hand side of Google 
Map Creator is the level of zoom. 
This relates directly to the zoom 
level in Google Maps. 

Moving the slider bar up and 
down will recalculate the ‘tile 
count’ which is the number of 
tiles that will be created when 
you click ‘create’. 

For street level data, you will want to choose the maximum level of zoom, 
whereas for global data a medium level is fine.

Now that the map is ready to create, there are a couple of options that can 
be added.  Once you are happy with your colours and tile count, simply click 
‘Create’.  Google Maps Creator will now create a folder containing all of the 
tiles, an XML file and a HMTL page ready to publish.

Setting the Colours
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Popular Maps 
in MapTube

Our latest release - MapTube 
- combines the generic idea 
of YouTube with the ability of 
Google Map Creator to create 
thematic maps. MapTube 
provides a ‘place to put maps’ 
where any map that is placed can 
be mixed and matched with any 
other map.

3 9Digital Geography: Geographic Visualisation for Urban Environments

The Mapping Revolution

Chapter Three



Creating and Viewing 
Maps in MapTube

In a Web 2.0 world, data is 
everything.  It is the key to 
knowledge and understanding. 
Spatial laboratories, such as ours 
at CASA, cannot survive without 
it.  We consume data at an ever 
increasing rate, process it, 
analyse it, manipulate and merge 
it to visualise and ultimately aid 
our understanding of the city 
and its geography.
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Data is a valuable asset and 
without it spatial analysis would 
simply not exist.  Google has been 
the analysts’ friend of late with 
its acquisition of high-resolution 
aerial photography providing a 
base for other datasets and that 
all important sense of location. 
As such, aerial imagery is one 
dataset that we no longer have to 
worry about, unless of course it is 
needed for visualisation outside 
of a Google product.

The use of Google’s license 
for aerial imagery is however 
just one dataset.  Research 
labs generally obtain data by 
linking up with other partners 
or providers and piggy backing 
on other license agreements, 
and it is here where the danger 
lies.  The need to consume and 
apply data often brings with it 
complications about copyright, 
intellectual property rights and 
licensing.

This is where MapTube steps in. 
Every map hosted on MapTube 
is held on an outside server and 
pulled in using the XML file 
which is automatically created 

when using Google Map Creator. 
As Google Map Creator effectively 
creates ‘image tiles’ from the 
data, the raw information is 
not placed online, only the data 
visualisation.  As such, issues of 
copyright are lessened as all the 
data is held outside of MapTube 
on servers around the world and 
the raw data is never shared. 
MapTube acts as a portal for 
geographic data, pulling it in 
whenever someone publishes a 
data set using our software and 
agrees to the map being shared.

Running as a portal, MapTube 
is unique in its ability to mix 
and match datasets.  It allows 
virtually any geographically 
located data to be overlayed with 
any other.  This allows an almost 
infinite number-of-combinations 
to be compared and visualised 
using the easy to use Google Map 
interface.

Using MapTube is simplicity 
itself, as a general user you can 
choose any number of maps to 
‘mashup’ on the fly.  Each layer 
can be mixed and matched to 
create the required visualisation 
which can then be saved and 
shared via a unique URL.

As a registered user, 
organizations or individuals can 
share their own data by typing 
in the location of their XML file.  
By adding a series of tags and 
general information, we ensure 
that the background to the data 
is kept intact and then MapTube 
does the rest. 

You can take MapTube for a spin 
at www.maptube.org.
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Google Map Creator requires 
a basic knowledge of data 
and, while it does a great job 
of converting existing maps 
that without such a tool may 
be destined to remain in local 
councils or research labs, it is not 
aimed at creating maps per se.

Placing you own data onto Google 
Maps used to mean getting 
your hands dirty via the Google 
Maps Application Programming 
Interface (API) and a request 
to Google for a license key.  This 
restricted map making to those 
determined to visualise data or 

those already at ease with basic 
code editing. Google changed 
this with the introduction of 
‘MyMaps’ in May 2007.  MyMaps 
is a simple point and click 
interface to create and edit your 
own maps and possibly the most 
important innovation in mapping 
since the development of 
Geographic Information Systems.

To create your own map you 
simply need a Google Account 
and to be able to point and click 
on a map; it is that simple.  As the 
Official Google Blog states, you 
can add placemarks, draw lines 

and shapes, and embed text, 
photos and videos -- all using a 
simple drag and drop interface. 
Your map automatically gets a 
public URL that you can share 
with your friends and family, 
or you can publish your map for 
inclusion in Google Maps search 
results.

To get started go to maps.google.
com  click MyMaps > Create 
New Map. You will see a series of 
icons on your map allowing you 
to create a Placemark, Line or 
Shape. Making maps has never 
been so simple.

MyMaps of the Geo-location of the  
Top 25 Web 2.0 CompaniesAdding Flickr to MyMapsTour of the GooglePlex
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Zooming into the Virtual 
London Model in Google Earth

The Digital Earth is a recent 
phenomenon.  It is barely 36 
months since the original 
Keyhole Earth Browser was re-
branded and launched as Google 
Earth, yet it could be argued that 
we already take for granted the 
ability to zoom into any location 
on the globe and view various 
levels of information and visual 
data in a three dimensional 
environment.

Google Earth was born out of 
Keyhole, a company founded 
by John Hawke with the aim 
of creating a 3D program 
called Earth.  Of note is 
Hawke’s inspiration from Neal 
Stephenson’s (1992) science 
fiction novel Snow Crash which 
describes a virtual earth created 
by the Central Intelligence 
Corporation (CIC). 

In this context, it is worth noting 
Stephenson’s description:

 “There is something new: A globe 
about the size of a grapefruit, a 
perfectly detailed rendition of 
Planet Earth, hanging in space at 
arm’s length in front of his eyes. 
Hiro has heard about this but 
never seen it.  It is a piece of CIC 
software called, simply, Earth.  
It is the user interface that CIC 
uses to keep track of every bit 
of spatial information that it 
owns, all the maps, weather 
data, architectural plans, and 
satellite surveillance stuff.   Hiro 
has been thinking that in a few 
years, if he does really well in 
the intel biz, maybe he will make 
enough money to subscribe to 
Earth and get this thing in his 
office.   Now it is suddenly here, 
free of charge”.
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3D City Elements

Phoenix The London Collection

Central to Google Earth is the 
ability to view three dimensional 
cities on top of the high 
resolution imagery, streamed 
in from numerous sources, 

either direct from the Google 
server, the 3D Warehouse which 
is a repository of user created 
models, or direct from a user’s 
machine or server.

User created content, also known 
as Crowd Sourcing, is central to 
the Digital Earth as no software 
company has either the money 
or the man-power to build a 
complete digital representation 
of all the structures on earth. 

The power of Web 2.0 is that it 
provides users with the tools 
and access to create content and 
as such, Google released a free 
version of their SketchUp 3D 

modeling tool in 2006, opening 
up the ability (and indeed 
requests from Google) for users 
to model their versions of the 
real world. 

Pictured below left are  
three collections from the 3D 
Warehouse.  The warehouse 
currently holds over 200,000 
models with the number rising 
by the day as users submit new 
content.

The best of these models 
become part of the Google Earth 
collection that are automatically 
streamed in when a user goes to 
the relevant section of a city - it 
is these models that are creating 
Google’s Digital Earth.
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Boston in Google Earth

Google’s 3D Warehouse route 
is classic Web 2.0 and opens up 
the use of 3D models for other 
applications such as CAD, 3D 
Studio Max or games software 
such as Crysis and Oblivion to 
name but a few packages. 

The user creates the content, 
Google gets to populate their 
earth and with content comes 
new users to SketchUp.  The cycle 
completes.  It is Wikinomics in 
action.

Of note in the images of Boston 
in Google Earth is the mix of 
user created content and generic 

3D grey outlines of buildings 
that were typical of Google 
Earth before texture mapping of 
geometry was introduced.

User created content allows local 
details to be mapped, creating  
realistic streetscapes.  The 
coverage is patchy, but it is still 
early days for the 3D Warehouse 
and its integration with Google 
Earth.

Microsoft have taken a different 
approach from Google with their 
Virtual Earth, currently in 
beta.  While they understand the 
need for users to add basic 3D 

models by way of their ‘3DVIA’ 
application (see www.3dvia.
com), they are modeling the 
world cities themselves, building 
by building.  Microsoft has 
invested in technologies to 
automatically recreate cities 
from a combination of aerial 
based Light Imaging and 
Detection Data (LiDAR) and 
oblique imagery.
The results are impressive 
with fully texture mapped 
geometrically accurate models 
being produced and loaded into 
Virtual Earth as and when 
complete.  With in excess of 500 
new cities planned for inclusion 
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New York in  
Microsoft’s Virtual Earth

in Virtual Earth, this year the 
battle between Microsoft and 
Google for users has commenced 
in earnest.

Commentators have compared 
it to the battle between the 
Netscape Browser and Internet 

Explorer.  Time will tell but with 
investment levels considerable 
for providing the most up to date 
aerial imagery, it is doubtful 
if there is room for 2 Digital 
Earths, let alone the 30 plus that 
currently exist.
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Creating PhotoOverlays in Google Earth
Software: www.casa.ucl.ac.uk/software/photooverlaycreator.asp

You will need:

1	x	Google Earth •	

1	x	Photograph or 		 •	
		  preferably a panorama 

1	x	Copy of PhotoOverlay 	•	
		  Creator from the url 	
		  above

Time Required:  
15 to 30 minutes

PhotoOverlay Creator has been made specifically to place high-resolution imagery into Google 
Earth. The tool supports full 360 x 180 degree panoramas, partial cylindrical panoramas and 
standard photographs or images, all within a simple point and click interface.

Working in a similar manner to our Google Map Creator software, the program tiles your data, in 
this case images, and creates a KML file ready to put on your server. KML is simply a file based on 
the XML language for three-dimensional geospatial data in Google Earth. Just as web browsers 
display HTML files, Digital Earth browsers such as Google Earth display KML files.

PhotoOverlay Creator essentially allows you to place any imagery into Google Earth on a three-
dimensional surface and in its correct geo-location.



PhotoOverlay Creator

Step 1: 
Launching and Loading 
an Image

Select File > Open File and choose 
the image you wish to display in 
Google Earth.

For this tutorial we are using a 
360 x 180 spherical panoramic 
image of the Chapel of St Peter 
and St Paul in Greenwich, 
London. 

The image loads and a level 
of zoom is automatically set 
according to the image’s 
resolution, in our case level 6.

Step 2:
Geo-Locating and Setting 
Field of View

Once your photograph or image 
is loaded, click ‘Create’ to be 
presented with options on Image 
Shape, Location and Description. 
Enter a description of your image 
- in our case information on the 
Chapel in Greenwich.  This text 
will be viewable in Google Earth.

Image Shape has 3 options:

1) 	Rectangle - for all images 
apart from panoramas.  The 
set Field of View (FOV) button 
provides options relating to 
the camera settings but for 
the most part, these can be 

Download the software from our 
website and unzip it into a folder.  
Note the software requires 
Java to be installed on your 
system which, if required, can 
be downloaded from www.java.
com.

To start PhotoOverlay, double 
click on PhotoOverlay.bat as 
pictured.

Loading the .bat file will open 
the interface which users of 
our other software tools, Image 
Cutter and Google Map Creator, 
will be familiar with.
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Geo-locating in Google Earth

ignored as the software will 
automatically set the correct 
sizes and aspect ratio.

2) Cylinder - for partial 
panoramic images or images 
that do not cover a full 360 
x 180 field of view.  The FOV 
settings are important for 
cylindrical images.  These 
should be noted down via your 
stitching software and input 
accordingly.

3) Panoramic Sphere - for 
use with 360 x 180 degree 
panorama images.

Select the Image Shape required 
as per the settings above, in 
our case Panoramic Sphere 
with the default FOV settings.  
As the images are located in 
geographic space, it is important 
to load them at the correct 
locations.  This can either be 
done accurately by noting the 
latitude and longitude of your 

image, or roughly by choosing a 
city location from the ‘Look Up’ 
option and later moved in Google 
Earth.

We are going to use the preferred 
method of looking up latitude and 
longitude using Google Earth. 
PhotoOverlay Creator uses 
latitude and longitude in degrees 
and decimals so we need to set 
our options in Google Earth to 
display these units.
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Setting Latitude and Longitude 
to Decimal Units in Google Earth

In Google Earth select Tools > 
Options and select the relevant 
check box under ‘Show Lat/Long’ 
- as illustrated.

The Chapel of St Peter and St 
Paul is located in Greenwich, 
London.  To get the relevant 
latitude and longitude we simply 
fly into the location in Google 
Earth and subsequently run 
the mouse over where the photo 
overlay is to be displayed.

The latitude and longitude are 
displayed in the bottom left hand 
corner of Google Earth.  Make 
a note of the co-ordinates and 
enter them into PhotoOverlay 
Creator.

Now simply click ‘Create’ and 
your KML will be created ready 
to view in Google Earth.

If you want to share your image 
with the world via a webserver, 
the KML needs to know the 
path to the image.  Open up your 
KML file in a text editor such 
as notepad and locate the .jpg 
reference - ours is here:

<icon>
<href>Chapel-tiles/Chapel_$[level]_$[x]_$[y].jpg</href>
</icon>
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Simply copy your newly created tiles folder to your webspace and note down 
the path.  Type this path after the <href>in your KML file

<icon>
<href>http://www.yourwebaddress/Chapel-tiles/Chapel_$[level]_$[x]_$[y].
jpg</href>
</icon>

Representing geographic data 
in three-dimensions is a step on 
from our Google Map Creator and 
towards Google Earth Creator. 
Google Earth Creator is due for 
release in the third quarter of 
2008 allowing you to take any 
.shp file and share it in three-
dimensions in Google Earth. 

As ever, updates and information 
can be found on our website 
www.casa.ucl.ac.uk and 
our blog www.digitalurban.
blogspot.com. 

Talking of blogs….

Three-Dimensional Data via 
Google Earth Creator
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According to Blogger, one the 
main providers of blogging 
software, a blog is “a personal 
diary... A daily pulpit.  A 
collaborative space.  A political 
soapbox.  A breaking-news outlet. 
A collection of links.  Your own 
private thoughts.  Memos to 
the world”.  In its purest sense 
and according to Wikipedia - 
blog, a portmanteau of web log 
- is a website where entries are 
commonly displayed in reverse 
chronological order.  “Blog” can 
also be used as a verb, meaning 
to maintain or add content to a 
blog. 

Blogger is a blog publishing 
system that is owned and 
operated by Google.  It was 
launched by Pyra Labs in 
1999 and introduced in its 
current form in 2004, after 
being acquired by Google for an 
undisclosed fee.

The key to blogs is they are easy 
to make.  Little or no technical 

knowledge is required allowing 
thoughts to be posted quickly 
with audio, images and video 
embedded by linking to other 
services such as Flickr or 
YouTube.

In short, blogs are a place to 
post thoughts and information, 
on whatever subject matter you 
choose, using a service such 
as Blogger which is free and 
characteristically easy to setup.

Blogger has provided an outlet 
for our work over the last couple 
of years through our blog known 
as Digital Urban.  Located at 
www.digitalurban.blogspot.
com, it has provided a focus 
for our thoughts and a way of 
sharing the information we have 
collated on urban and geographic 
visualisation. 

Within this area, there are a 
number of core blogs, which we 
highlight over the next couple of 
pages. 
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www.gearthblog.com www.edparsons.com www.digitalgeography.co.uk

www.spatiallyadjusted.com www.archsl.wordpress.com www.cgarchitect.com
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www. gisagents.blogspot.com www.cityofsound.com/blog www.ogleearth.com
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Avatars in Second Life

Second Life and other similar 
virtual environments are easy 
to dismiss as pure distraction 
and entertainment.  Yet look 
under Second Life’s lid and it has 
the potential to combine all the 
aspects of Web 2.0, visualisation 
and Neogeography in one 
multi-user, three-dimensional 
collaborative environment. 

Second Life is but the tip of an 
iceberg.  It represents a glimpse 
into the future of collaboration 
and visualisation.  Overlapping 
with systems such as Google 
Earth and toying with the 
concept of populated space, 
within the next few years the 
predictions are for a ‘Second 
Earth’:  a merger of Google Earth 
and Second Life.  Second Earth is, 
in short, an occupied version of 
the Digital Earth.

Perhaps a Second Earth is Web 
3.0 or 4.0, a long way off in terms 
of the short run cycles of current 
technology, but the indications 
are there and companies are 
already working on prototypes.  
Chasing the future is typical 
of digital geography.  The next 

big thing in visualisation or 
communication is always around 
the corner.  Back to the current 
state of the art and at the present 
time of writing (February 
11th 2008, 14:20 hours), there 
are 34,954 people logged into 

Second Life, living their virtual 
lives.  These lives and the 
environments in which they 
exist are worth exploring.

Second Life currently represents 
the most successful social/visual 
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CASA’s Lab in Second Life as part of 
NATURE Island

environment on the Internet.  
Launched in 2003 with little 
more than a few kilometres of 
simulated computer space, it now 
covers more than 750 square 
kilometres.  Created by Linden 

Labs, based on Linden Street 
in San Francisco, the world of 
Second Life has been created 
almost in its entirety by its 
users.  The users have created 
digital geography in its purest 
geographic sense.  The rolling 
fields, river valleys, mountains, 

hamlets and towns that occupy 
the ever growing 750 square 
kilometres have been created 
piece by piece by the millions of 
users. 

Neal Stephenson’s influence can 
again be felt in environments 
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such as Second Life that mirror 
his vision of the Metaverse. 
Stephenson’s novel Snow Crash 
depicts life in the Metaverse as 
the following:

“As Hiro approaches the Street, 
he sees two young couples, 
probably using their parents’ 
computer for a double date in the 
Metaverse, climbing down out 
of Port Zero, which is the local 
port of entry and monorail stop.  
He is not seeing real people of 
course.  This is all part of the 
moving illustration drawn by 
his computer according to the 
specifications coming down the 
fiber-optic cable.  The people 
are pieces of software called 
avatars”.  Neal Stephenson, Snow 
Crash (1992, p.35).

Users can ‘jack in’ and ‘jack 
out’, to adopt the terminology of 
Snow Crash, creating a flux in 
population levels.  During August 
2007, 23 million man-hours were 
spent in Second Life by over 
974,000 users, that’s an average 
of 23.6 hours per user.  Hof 
(2006), in an article in Business 
Week, indicating Second Life’s 

spreading influence, estimated 
that residents spent a total of 
23,000 hours a day creating 
things, something that would 
take a 4,100 strong software 
team to do.

This is pure Web 2.0 in action.  A 
cumulative workforce operating 
inside a virtual world creating 
digital geography.  It is quite 
simply staggering.

Visualising Cities in Second Life

To start using Second Life all you 
need do is download the viewer, 
available for Windows, Mac and 
Linux from www.secondlife.
com downloads.

It is free to enter Second Life, 
chat and begin exploring.  If you 
want to start ‘building’, then you 
need to register and purchase 
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From MapTube to Second Life

Chicago Panorama as an ‘Urban Sphere’

land using the currency of 
Second Life – Linden Dollars. 

A Premium Second Life account 
starts at $9.95 a month and 
allows you to claim a plot of 
land on which you can build. 
The registration fee includes a 
complementary 512 x 512 metre 
allocation of real estate.  Any 
amount of land can be ‘rented’ 
from Linden Labs with a number 
of companies, universities and 
institutions occupying their own 
Islands in Second Life.

Our section of land in Second 
Life can be found on NATURE 
Island, a plot of land set up 
by the NATURE publishing 
group to encourage scientific 
research and outreach.  We have 
set up a number of examples 
of geographic visualisation 
including maps directly 
linked to MapTube, real-time 
display of weather data from 
‘Neometeorologists’ and ‘Step 
Inside’ urban spheres.
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A Selection of ‘Prims’ in Second Life

Building in Second Life is 
simplified by a powerful and 
highly flexible tool set built into 
the Second Life browser.  All 
objects in Second Life are created 
from a series of geometric 
primitives known as prims.  
These are the basic building 
blocks and each prim can be 
hollowed, flexed and shaped as 
required to create any required 
geometry.

It is worth going to a ‘sandbox’ 
area to practice building.  These 
are areas that allow anyone to 
try out building techniques and 
are often supported by a number 
of nearby tutorials. 

The best way to start out and 
learn Second Life is not from the 
printed word but either inside 
Second Life itself or by running a 
search for ‘Second Life Tutorial’ 
on YouTube.  With resources 
such as YouTube, and various 
blogs at your fingertips, all that 

is required is an hour of time and 
you will be part of the collective 
that are creating the digital 
geographies and digital cities 
that are Second Life.

In essence, we are but at the 
beginning of what will be a 
revolution in social, visual 
and informational data plotted 
geographically by general users 
– Neogeographers.  New tools are 
emerging on ever shortening 
software cycles and hardware is 
emerging that integrates geo-
positioning as a matter of course. 
Mapping and visualisation is 
getting easier.  Geography is 
important again and data is 
opening up to the masses.  In 
short, these are interesting times 
in the world of digital geography.

A booklet is only as timely as its 
print date.  As ever you can find 
out the latest innovations, news 
and techniques on our blog www.
digitalurban.blogspot.com.

Welcome again to the new world 
of rich geographic information 
– Digital Geography – in its new 
form Neogeography.
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Second Lives

Iconic Geography:  London Tube Map
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Web 2.0 is a collection of computer technologies that are changing the 
way we represent digital media.  Location and place are fast becoming 
a third force in the IT revolution, central to the way we interact with one 
another and search for information.  This booklet describes the mapping 
revolution that is upon us, illustrating how the development of digital earth 
and virtual worlds are creating a Neogeography in which we can all share.
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